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Preface

This guide describes the tasks a system administrator performs to install the WebSDM 
and Empirica Study application, version 3.1.2.1. 

Audience
This guide is for system administrators and database administrators who are familiar 
with Oracle relational databases and who host the WebSDM and Empirica Study 
application in their own environments, rather than contracting for this service from 
Oracle.

This guide assumes familiarity with administrative tasks, including setting up and 
configuring the Oracle database, administering IIS, configuring Windows Services, 
and setting Windows file permissions. Most of these steps are performed on the 
Windows 2003 or Windows 2008 server that hosts the WebSDM and Empirica Study 
software.

Using this Guide
Oracle recommends that you familiarize yourself with these procedures by reading all 
instructions before you begin the installation.

While the instructions provided in this guide are detailed, they are generic. This guide 
cannot, and is not intended to, cover all possible variations that might occur. An 
experienced administrator should read all instructions and be prepared to work 
through site-specific differences from the provided instructions.

Conventions
The following text conventions are used in this document:

Note: In the remainder of this guide, the product name WebSDM 
references both the WebSDM standalone product and WebSDM with 
the optional Empirica Study features that require additional licensing. 

Convention Indicates

Courier font A file or directory name or Command Prompt window.

boldface font User interface controls, including menu options, buttons, and links.

<text_in_angle_
brackets>

To substitute the values in the Prerequisites tables for the <text_in_
angle_brackets>.

Optional A procedure or step that is not required for all installations.
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Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
For more information, see the following documents in the Oracle Health Sciences 
WebSDM and Empirica Study 3.1.2.1 documentation set:

■ Oracle® Health Sciences WebSDM and Empirica Study Known Issues

■ Oracle® Health Sciences WebSDM and Empirica Study Release Notes

■ Oracle® Health Sciences WebSDM and Empirica Study Upgrade Instructions

■ Oracle® Health Sciences WebSDM and Empirica Study Third Party Licenses and Notices

Note: Information of particular significance.

32-bit server

64-bit server

Server-specific alternative instructions.

(Windows 2008 server)

(Windows 2003 server)

Instructions that are different for Windows 2008 and 2003. Complete 
only the instructions for the operating system that you are running.

Convention Indicates
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1Installing WebSDM 3.1.2.1 

To install WebSDM, you need to:

1. Set up the database. 

2. Install the WebSDM software.

3. Install the supporting software.

4. Configure the properties files.

5. Start the application service.

6. Perform post-installation procedures.

7. Optional: Customize WebSDM.

8. Verify the WebSDM installation.

1.1 Prerequisites

1.1.1 Required Servers, Software, and Media
Before you begin the installation, ensure that you have the following servers, software, 
and installation media:

■ A Windows 2003 or 2008 server to host the WebSDM application. Note whether 
the server is 32-bit or 64-bit.

■ Oracle 10g (10.2.0.3 or higher) or Oracle 11g (11.2.0.2 or higher) installed on a 
server. The Oracle installation can be on the same or a different Windows server 
than the WebSDM software. If on different Windows servers:

– The Oracle installation must be Oracle Database Enterprise Edition if you plan 
to encrypt the communications channel between the servers. The Windows 
server must have been restarted at least once since the Oracle installation.

– Oracle Net Service must be installed on the Windows server where the 
WebSDM software is installed.

– Both servers must be set to the same time zone.

■ An Oracle database instance (Oracle SID or Service) to support WebSDM.

■ IIS installed on the Windows server.

■ SMTP mailer enabled on the Windows server.
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■ An installation of R for Windows (32-bit, version 2.13.2 only). See Appendix A, 
"Notes on the Installation of R" for installation notes.

■ A file compression and extraction utility, such as WinZip. 

■ Internet Explorer version 7 or 8.

■ MedDRA ZIP files obtained under a subscription from MSSO.

■ The WebSDM 3.1.2.1 installation media. This is the product ZIP file from My 
Oracle Support (https://support.oracle.com).

■ If you are enabling SSO, a server with the Oracle Access Manager (OAM) 
installed. See Appendix C, "Configure WebSDM for SSO".

■ If you expect to load study data from an Oracle Life Sciences Data Hub (LSH) 
database, identifying information about that server. See Appendix D, "Configure 
WebSDM to Access an Oracle Life Sciences Data Hub Instance".

■ If you expect to load study data from an Oracle Health Sciences InForm database, 
identifying information about that server. See Appendix E, "Configure WebSDM to 
Access an Oracle Health Sciences InForm Instance".

You must also have access to the Java jar and jarsigner utilities and to your company's 
jar signing process.

1.1.2 Required Information about Existing Accounts and Services
You need the following names and passwords for accounts and services, which must 
already exist when you start the installation. In these procedures, the values are shown 
in <text_in_angle_brackets>.

■ Windows administrator account

<win_admin_acct> and <win_admin_pass>

Windows account and password on the Windows 2003 or 2008 server where you 
will install WebSDM. The account must be assigned the Administrator role.

■ Optional: Administrator account and password for the Oracle server

< winDB_admin_acct> and <winDB_admin_pass>

If the Oracle database is not installed on the same Windows server as the WebSDM 
software, you also need a Windows account and password on the server where the 
Oracle database is installed. The account must have sufficient permissions to edit 
the Oracle sqlnet.ora file.

■ Optional: Oracle root installation directory

<oracle_root>

If WebSDM and the Oracle database are to be installed on different Windows 
servers, and you plan to encrypt the communications channel between them, you 
must know the root directory where Oracle is installed.

■ Oracle DBA account

<ora_dba_acct> and <ora_dba_pass>

This is the Oracle account and password for the Oracle instance that supports 
WebSDM. The account must be assigned the DBA role.

■ Oracle service name or SID

<ora_service_name> or <ORA_SID>
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Oracle SID or Oracle service name for the Oracle instance that supports WebSDM.

■ Oracle host name 

<ora_host>

The server host on which the Oracle SID or Oracle Service is installed. If the server 
host is the same one on which you are installing the WebSDM software, use the 
host name localhost. If the Oracle database is hosted on a different server, use that 
server name.

■ Oracle port 

<ora_port>

The port on which the Oracle SID or Oracle Service name is executing. The default 
is 1521.

■ First or subsequent install

<is_first_install>

To determine the procedures to follow for this installation, ascertain whether other 
related Oracle products are already installed on the server. 

Use Windows Explorer to inspect all root directories on the file system for a 
<root>\Lincoln subdirectory. If this subdirectory does not exist, the value of <is_
first_install> is true. The instructions indicate those steps that need to be 
completed only for the first install.

If a <root>\Lincoln subdirectory already exists on the application server, then 
<is_first_install> is false. Contact Oracle before proceeding with this installation.

■ Installation root

<root>

File system root where the \Lincoln subdirectory was found. If it was not found, 
select the drive where you want to install WebSDM. The recommended location is 
c:\.

■ Submissions folder

<submissions_folder>

File system drive and directory to serve as the root where clinical data submissions 
(applications and study data) will be stored. The recommended location is 
d:\ClinicalData.

■ Optional: OAM Server

<oam_server>

If you are enabling SSO and want to set a logout redirect page, you must provide 
the fully qualified name for the OAM server.

1.1.3 Removing and Setting the Read-only Attribute
If the installation instructions require you to edit a file, check the file properties to see 
if the read-only attribute has been set. If set, you must remove it before editing. To 
remove the read-only attribute:

1. Open Windows Explorer and navigate to the file.

2. Right-click the file name and select Properties.

3. Clear the Read-only option.
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4. Click OK.

When you are done editing the file, reset the read-only attribute:

1. Open Windows Explorer and navigate to the file.

2. Right-click the file name and select Properties.

3. Select the Read-only option.

4. Click OK.

1.1.4 Saving Files
If the installation instructions require you to edit a file, be sure to save the file with the 
original name. Some editors by default add the TXT extension to the file name.

1.1.5 Required Information for New Accounts and Services
During installation, you provide names and passwords for accounts and services that 
are created. Ensure that all passwords comply with your company security policy. 
Database passwords must also comply with password requirements for the Oracle 
version that you are using.

■ WebSDM instance name

<instance>

Name you provide for the WebSDM instance. The installation uses this name for 
several components, including a Windows service, a virtual directory, and a folder. 
The default name is websdm. Using the default name reduces the number of files 
you must edit during the installation. If you are installing more than one WebSDM 
instance on the Windows server, the <instance> name must be unique for each 
server.

■ Oracle net service name

<ora_net_service>

Name for the Oracle net service for the WebSDM database.

■ Oracle tablespace name

<ora_tablespace>

Name for the Oracle tablespace for the WebSDM database. Oracle recommends 
that you use the same name you used for the WebSDM instance name.

■ Oracle master account and password for WebSDM

<websdm_master_acct> and <websdm_master_pass>

Name and password for the Oracle account that the installation creates to store 
data for the WebSDM instance. Oracle recommends that you use the same name 
you used for the WebSDM instance name.

■ WebSDM application admin account default password

<app_admin_pass_default>

Password for the WebSDM user account with the reserved name 'admin'. Email 
Oracle at safetysupport_ww@oracle.com for the initial default password for the 
admin account.

■ WebSDM application admin account final password
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<app_admin_pass>

You must change the password of the WebSDM application admin account the 
first time you log into WebSDM.

■ MedDRA account passwords

<meddraX_ora_pass> 

You must provide passwords for the Oracle accounts that are created for each 
version of MedDRA.

■ IIS default application

<is_IIS_default_app> 

Determine whether to make WebSDM the default application for your IIS 
installation. If you do, then <is_IIS_default_app> is true. Otherwise, it is false. The 
instructions include the steps to make WebSDM the default application for your 
IIS installation. If WebSDM is not the default applications for IIS, you can skip 
these steps.

1.2 Set Up the Database

1.2.1 Setting Up the Oracle Net Service
Create an Oracle net service that points to the Oracle service or SID that WebSDM will 
use to store data. 

1. Start Oracle > Configuration and Migration Tools > Net Manager.

2. Click Local to see the options, and select Service Naming.

3. Create a new service name.

a. From the Edit menu, select Create.

or

b. Click the Create (green plus sign) icon. 

4. For the Net Service Name, type the value of <ora_net_service>.

5. Click Next.

6. For Protocol, select TCP/IP (Internet Protocol).

7. Click Next.

8. For Hostname, if WebSDM and the Oracle database are installed on the same 
Windows server, enter localhost. If the Oracle database is installed on a different 
Windows server, enter the <host_name>.

9. For Port, accept the default 1521, unless your DBA has supplied a different value 
for <ora_port>.

10. Click Next.

Note: If <is_first_install> is false, complete this section only if the 
WebSDM instance you are installing uses a different Oracle Service or 
SID.
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11. If you are using an Oracle 10g database, select the Oracle 8 or Previous radio 
button.

a. For SID, type the value of <ORA_SID>.

b. Click Next.

or

if you are using an Oracle 11g database, for Service Name, type the value of 
<ora _service_name>.

c. For Connection Type, select Dedicated Server.

d. Click Next.

12. Optionally, to verify the settings, click Test. 

a. If the test completes successfully, click Close. 

b. If the test fails, edit the settings and try the test again.

13. Click Finish. 

The settings for the Oracle net service appear.

14. From the File menu, select Save Network Configuration. 

15. Exit Oracle Net Manager.

1.2.2 Encrypting the Database Connection
If WebSDM and the Oracle installations are on different servers, complete the 
following instructions to encrypt the communications channel between the servers.

If the WebSDM and Oracle installations are on the same Windows server, continue to 
Section 1.2.3, "Setting Up the Oracle Master Account and Tablespaces for WebSDM". 

1. Log onto the <winDB_admin_acct> account on the machine where the Oracle 
database is installed. 

2. Navigate to the <ora_root>\network\admin folder.

3. Use a text editor, such as Notepad, to open the SQLNET.ORA file and add these 
lines at the end:

SQLNET.ENCRYPTION_SERVER = accepted
SQLNET.CRYPTO_CHECKSUM_SERVER = accepted
SQLNET.ENCRYPTION_TYPES_SERVER = (RC4_256)
SQLNET.CRYPTO_CHECKSUM_TYPES_SERVER = (MD5,SHA1)

These settings enable both encrypted and unencrypted connections. 

4. In an environment where encryption is required for all connections, change the 
setting of the first added line as follows:

SQLNET.ENCRYPTION_SERVER = required

5. Save your changes to the SQLNET.ORA file.

6. Log onto the <win_admin_acct> on the Windows server where you are installing 
WebSDM.

7. Navigate to the <ora_root>\network\admin folder.

8. Use a text editor, such as Notepad, to open the SQLNET.ORA file and add these lines 
at the end:
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# This line is optional
SQLNET.CRYPTO_SEED = 'at least 10 chars'
SQLNET.ENCRYPTION_CLIENT = requested
SQLNET.CRYPTO_CHECKSUM_CLIENT = requested
SQLNET.ENCRYPTION_TYPES_CLIENT = (RC4_256)
SQLNET.CRYPTO_CHECKSUM_TYPES_CLIENT = (MD5, SHA1)

These settings ensure that connections from the WebSDM server always request an 
encrypted channel, and also work if the database does not support encrypted 
connections.

9. Save your changes to the SQLNET.ORA file.

1.2.3 Setting Up the Oracle Master Account and Tablespaces for WebSDM
Run scripts to create the Oracle master account and tablespaces for WebSDM.

1. Locate the database-3_1_2_1_xxx.zip file (where xxx represents a specific build 
number) on the installation media, and extract the contents of this file to a 
temporary location, such as c:\install\database.

2. Use a text editor, such as Notepad, to open the 1_create_tablespace.sql file and 
review the DEFINE statements.

3. Verify that the ORADATA file path points to your preferred location for the 
tablespace data files.

4. If the value of <ora _tablespace> is something other than websdm, change the 
value of TABLESPACE_NAME to that value.

5. Verify that the referenced TABLESPACE_NAME and DATAFILE do not already exist. 
You can do so by executing each of these SQL queries in order:

select tablespace_name from dba_tablespaces;8
select file_name from dba_data_files;

6. Review the default sizing parameter values. The default values are suited to an 
environment where study data is loaded into application-specific tablespaces. If, 
instead, you are loading all study data into a single tablespace and registering 
100+ studies, it might be reasonable to double the size parameters.

7. If changes are needed, edit, save, and close the file.

8. Use a text editor to open the 2_create_oracle_user.sql file and review the 
DEFINE statements. This script creates the WebSDM master account and grants 
permissions to it.

9. If the value of <websdm_master_account> is something other than websdm, 
change the value of USER_NAME to that value.

10. If the value of <ora _tablespace> is something other than websdm, change the 
value of TABLESPACE to that value.
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11. If changes are needed, edit, save, and close the file.

12. Open a command window and change the directory to the temporary directory.

13. From the <ora_dba_acct> account, run the 1_create_tablespace SQL script. For 
example:

a. Type this command on one line:

C:> sqlplus <ora_dba_acct>@<ora_net_service>
@c:\install\database\1_create_tablespace

b. When prompted for the password, enter <ora_dba_pass>.

c. Scroll up to review the results of running script 1_create_tablespace. There 
should be no errors.

14. From the <ora_dba_acct> account, run the 2_create_oracle_user SQL script. For 
example:

a. Type this command on one line:

C:> sqlplus <ora_dba_acct>@<ora_net_service>
@c:\install\database\2_create_oracle_user

b. When prompted for the password, enter <ora_dba_pass>.

c. When the script prompts you for the WebSDM master account password, type 
the value of <websdm_master_pass>.

d. When prompted to confirm the password, again type the value of <websdm_
master_pass>. If confirmation fails, the script exits and you can run it again.

e. Scroll up to review the results of running script 2_create_oracle_user. There 
should be no errors.

15. From the newly created WebSDM master account, run the 3_create_all SQL 
script. For example:

a. Type this command on one line:

C:> sqlplus <websdm_master_acct>@<ora_net_service> 

Note: For WebSDM to be fully functional, this script must be 
executed with the SQL statements it currently contains. If certain 
permissions are not granted to the Oracle master account for 
WebSDM, the application runs with some functionality disabled. 
Specifically:

■ If the CREATE TABLESPACE permission is not granted, the 
Create a new tablespace for each Application radio button is 
disabled on the Site Options page. In addition, all application and 
study level accounts will use a common tablespace

■ If the DROP USER permission is not granted, the Action menus 
attached to Applications, Studies, and Study Pools on the Setup 
tab does not contain entries that allow properly authorized users 
to delete those objects. 

■ If the DROP TABLESPACE permission is not granted, but 
CREATE TABLESPACE and DROP USER are granted, the 
dedicated tablespace contents are deleted when an application is 
deleted, but the tablespace itself is not deleted.
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@c:\install\database\3_create_all

b. When prompted for the password, enter <websdm_master_pass>.

c. Review the contents of the C:\install\database\3_create_all.log file 
created by running this script. There should be no errors.

16. Close the command window.

1.3 Install the WebSDM Software

1.3.1 Installing New Website Files
Complete these steps only if <is_first_install> is true.

1. Use Windows Explorer to view the installation media. Locate the following file:

32-bit server: Lincoln.zip 

64-bit server: Lincoln_x64.zip 

2. Extract the contents of this file to <root>, making sure the path names stored in the 
archive are used. For example, in the WinZip Extract dialog box, be sure to check 
the Use folder names checkbox.

1.3.2 Configuring Existing Website Files
Complete these steps only if <is_first_install> is false or if the value of <instance> is 
something other than websdm.

1. Use Windows Explorer to view the installation media. Locate the following file:

32-bit server: Lincoln.zip 

64-bit server: Lincoln_x64.zip 

2. Extract the contents of this file to a temporary folder on the server, such as 
C:\temp, making sure that the path names stored in the archive are used. For 
example, in the WinZip Extract dialog box, be sure to select the Use folder names 
checkbox.

3. If the value of <instance> is something other than websdm, change the name of 
the directory from:

C:\temp\Lincoln\apps\websdm

to:

C:\temp\Lincoln\apps\<instance>

4. Copy the <instance> folder (and all its files and subdirectories) from:

C:\temp\Lincoln\apps 

to:

<root>\Lincoln\apps\

5. Navigate to the <root>\Lincoln\IIS\conf\ folder.

6. Use a text editor to open the uriworkermap.properties file.

7. Scroll to the last line of this file. Change websdm to the value of <instance>. For 
example, if the <instance> is websdmProd, change:
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/*/*.jsp=websdm

to: 

/*/*.jsp=websdmProd

8. Add the following lines to this file, substituting the value of <instance> for all six 
occurrences of websdm.

/*/websdm /*.jsp=websdm 
/*/websdm /servlet/*=websdm 
/*/websdm /services/*=websdm 

9. Save your changes to the uriworkermap.properties file.

10. Edit the <root>\Lincoln\IIS\conf\workers.properties file to add <instance> to 
the end of the comma-separated list of applications for the worker.list property. 
For example, if the <instance> is websdmProd, the edited line is: 

worker.list=websdm, websdmProd

11. Add the following lines to this file, substituting the value of <instance> for all 
three occurrences of websdm:

worker.websdm.port=8009
worker.websdm.host=localhost
worker.websdm.type=ajp13

12. Compare the value specified for the newly added port property to the other port 
numbers already specified in this file. If this value (8009) is already assigned to 
another application, you must supply a different port number for this instance of 
WebSDM to use. Select a port number that is two greater than the highest port 
number specified elsewhere in the file and change the value for the port property 
to that value. For example, if the highest port number is 8009, use the value 8011.

13. Save your changes to the workers.properties file.

14. Check for the existence of the folder <root>\Lincoln\apache-tomcat-6.0.41 
(earlier releases of WebSDM used other versions of tomcat, so this folder might not 
exist). If this folder does not exist, copy the folder named apache-tomcat-6.0.41 
(and all its files and subdirectories) from C:\temp\Lincoln to <root>\Lincoln\.

For example, from:

Note: The file should contain the three lines for each instance of 
WebSDM that is installed on the machine. If Empirica Signal is also 
installed, there will be three slightly different lines for each instance of 
the Empirica Signal application.

Note: The worker.list element should contain an entry for each 
instance of an Oracle product (WebSDM or Empirica Signal) that is 
installed on the machine.

Note: The file should contain the three lines for each instance of an 
Oracle product (WebSDM or Empirica Signal) that is installed on the 
machine.
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C:\temp\Lincoln\apache-tomcat-6.0.41

to: 

<root>\Lincoln\apache-tomcat-6.0.41

15. Check for the existence of the folder <root>\Lincoln\jdk1.6 (earlier releases of 
WebSDM used jdk 5, so this folder might not exist).

a. If the <root>\Lincoln\jdk1.6 folder does not exist, copy the folder named 
jdk1.6 (and all its files and subdirectories) from C:\temp\Lincoln to 
<root>\Lincoln\.

b. If the <root>\Lincoln\jdk1.6 folder exists, determine the specific version of 
the jdk by opening a command window and executing the following 
command:

<root>\Lincoln\jdk1.6\bin\java.exe -version

If the response indicates a version earlier than 6.0_81, replace the jdk1.6 
folder in <root>\Lincoln with the one in C:\temp\Lincoln.

1.3.3 Configuring the server.xml File
Complete these steps if the value of <instance> is something other than websdm, or if 
you edited the workers.properties file to change the port number to a value other 
than 8009.

1. Navigate to the <root>\Lincoln\apps\<instance>\conf folder.

2. Use a text editor to open the server.xml file.

3. If the value of <instance> is websdm, skip to step 6.

4. Locate the Host element and its appbase attribute. Change websdm to the value 
of <instance>.

<Host name="localhost" appBase="C:/lincoln/apps/websdm/webapps">

5. Locate the Context element and its path attribute. Change websdm to the value of 
<instance>.

<Context path="/websdm">

6. Locate the Connector element and its port attribute. If you changed the value of 
the port element in the workers.properties file, change the value of the 
Connector port element to the same value. For example, if the value was changed 
to 8019:

<Connector port="8019">

7. Locate the Server element and its port attribute. Change the value of the port 
element to one less than the value you specified for the Connector port element. 
For example, if you changed the Connector port element to 8019, change the 
Server port element to 8018.

<Server port="8018">

8. Save your changes to the server.xml file.

Note: The apache-tomcat-6.0.41 folder required for WebSDM can 
coexist with other Tomcat versions that have been installed for other 
products.
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1.3.4 Setting Up Website Files
1. Locate the websdm-3_1_2_1_xxx.zip file (where xxx represents a specific build 

number) on the installation media. Extract the contents of this file to the 
<root>\Lincoln\apps\<instance>\webapps\web_root\ folder (created 
automatically in the previous task).

2. Locate the Oracle installation folder on the WebSDM server. For example, 
D:\oracle\product\11.2.0\db_1.

3. Using Windows Explorer, navigate to the <root>\Lincoln\IIS\conf\ folder. 
Review the file paths in the iis_redirect.reg file using a text editor. Edit the file 
paths, if necessary, to reflect any changes you made for your installation.

4. Double-click the iis_redirect.reg file. Click Yes, and then click OK.

5. In the same folder, double-click the iis_cipher_configuration.reg file. Click 
Yes, and then click OK. 

1.3.5 Installing an Encryption Key
1. Navigate to the folder <root>\Lincoln\apps\<instance>\webapps\web_

root\WEB-INF\classes.

2. Check for existence of the file license.config. If it exists, rename it to another 
name, such as license.old.

3. Navigate to the folder <root>\Lincoln\apps\<instance>\bin.

4. Use a text editor to open the file generate_keys.bat and review the values of 
INSTALL_ROOT and APPLICATION_DIR. If changes are needed, edit and save the file.

a. If the value of <instance> is other than websdm, change the value of the 
APPLICATION_DIR to the value of <instance>.

b. If the value of <root> is other than the c drive, change the value of the 
INSTALL_ROOT to the value of <root>.

5. (Windows 2008 server) Right-click the generate_keys.bat file, and then select Run 
as administrator.

or

Note: If the database is running on a machine other than the 
application server, the Oracle installation folder refers to the path 
where Oracle client components were installed.

From within the \jdbc\lib subfolder, copy the following .jar file to 
the <root>\Lincoln\apps\<instance>\webapps\web_
root\WEB-INF\lib folder, overwriting the existing file, if necessary. If 
you are using Oracle 10g, locate ojdbc14.jar. If you are using Oracle 
11g, locate  ojdbc6.jar.

Note: This updates the registry. Perform this step even if you did not 
make any changes to the iis_redirect.reg file.

Note: This disables weak IIS ciphers.
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(Windows 2003 server) Double-click the generate_keys.bat file.

6. Examine the script output. Verify that the last two lines are:

[INFO] Generating <root>\Lincoln\apps\<instance>\webapps\web_
root\WEB-INF\classes\license.config

[INFO] Done

7. When prompted, press any key.

8. If the last two lines of script output are not as indicated, correct the error condition 
and repeat this procedure.

1.3.6 Optional: Making WebSDM the Default Application
If <is_IIS_default_app> is true (WebSDM is to be the default IIS application), perform 
the following steps:

1. Open the <root>\Lincoln\apps\<instance>\webapps\web_root\index.html file 
in a text editor, such as Notepad.

2. Insert <instance> into the URL in this line. For example, if the value of <instance> 
is websdm, change:

<META HTTP-EQUIV=REFRESH CONTENT="0; URL=./login.jsp">

to:

<META HTTP-EQUIV=REFRESH CONTENT="0; URL=/websdm/login.jsp">

3. Save your changes.

4. Copy the <root>\Lincoln\apps\<instance>\webapps\web_root\index.html file 
to the C:\inetpub\wwwroot directory.

1.3.7 Configuring IIS

1.3.7.1 Configuring IIS for Windows 2008
This section is for Windows 2008 Server only.

1. Launch Server Manager and expand the Roles node.

2. Add the Web Server (IIS) role if it does not already exist.

3. Add Services to the role:

a. Right-click Web Server (IIS), and select Add Role Services.

b. Select the following additional role services under Application Development:

ISAPI Extensions

ISAPI Filters

c. Click Next.

d. Click Install.

e. Click Close.

4. Click Start > Administrative Tools > Internet Information Services Manager.

5. Select the first node in the tree control.
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6. Under IIS, in the middle pane, double click Mime Types. In the list of registered 
file types, check for the presence of the .app file extension.

7. If the .app extension is not already listed, click Add. For Extension, type .app. For 
MIME type, type text/plain. Click OK.

8. In the list of registered file types, check for the presence of the .wsdl file extension.

9. If the .wsdl extension is not already listed, click Add. For Extension, type .wsdl. 
For MIME type, type text/plain. Click OK.

10. If <is_first_install> is false, skip to step 24. If <is_first_install> is true, select your 
server name in the Connections pane.

11. Under IIS, double-click ISAPI and CGI Restrictions.

12. On the Actions pane, click Add.

13. On the ISAPI or CGI Restrictions pop-up, complete the following:

ISAPI or CGI Path: <root>\Lincoln\IIS\bin\isapi_redirect.dll 

Description: jakarta

14. Select Allow extension path to execute, and click OK.

15. On the Connections pane under Sites, under your server name, select Default 
Web Site.

16. In the IIS section of the middle pane, double-click ISAPI Filters.

17. On the Actions pane, click Add.

18. Add a filter with the following characteristics, and click OK.

Filter name: jakarta

Executable: <root>\Lincoln\IIS\bin\isapi_redirect.dll

19. Right-click Default Web Site, and select Add Virtual Directory. Type the 
following, and then click OK.

Alias: jakarta

Physical Path: <root>\Lincoln\IIS\bin

20. From the Connections pane, select jakarta and, in the IIS section of the middle 
pane, double-click Handler Mappings.

21. In the Actions pane, select Edit Feature Permissions.

22. Ensure that Read, Script, and Execute are selected. If they are not, select them and 
click OK.

23. Right-click Default Web Site and select Add Virtual Directory. Type the 
following, and click OK.

Alias: <instance>

Physical Path: <root>\Lincoln\apps\<instance>\webapps\web_root

24. From the Connections pane, select <instance> and, in the IIS section of the middle 
pane, double-click Handler Mappings.

a. In the Actions pane, select Edit Feature Permissions.

b. Ensure that Read and Script are selected. If not, select them and click OK.

25. From the Connections pane, select <instance> and then, in the IIS section of the 
middle pane, double-click Default Document.
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a. From the list of documents, select index.html document and use the Move Up 
function until index.html is at the top of the list.

b. If prompted to confirm the changed list order, click Yes.

c. If document index.html is not listed, create it using the Add button. Move this 
document to the top of the list.

d. In the Actions pane, verify that Disable appears as an action. If Enable 
appears instead, click it and verify that Disable appears as an action. 

26. On the Connections pane in the Sites folder under your server name, select 
Default Web Site.

a. In the IIS section of the middle pane, double-click Error Pages.

b. On the Actions pane, click Edit Feature Settings.

c. On the Edit Error Pages Settings dialog, select Detailed errors.

d. Click OK.

27. Select Start > Control Panel > System and Security > Administrative Tools / 
Services. 

28. Right-click the World Wide Web Publishing Service, and click Restart.

Alternatively, run the following commands at a DOS prompt:

C:\ net stop w3svc

C:\ net start w3svc

1.3.7.2 Configuring IIS for Windows 2003
This section is for Windows 2003 Server only.

1. Select Start > Settings > Control Panel > Administrative Tools > Internet 
Services Manager.

2. If <is_first_install> is false, (<root>\Lincoln already exists), expand the tree 
and skip to step 12 of this procedure.

3. Right-click the first node in the tree control. Select Properties. In the MIME types 
section, click MIME Types.

a. In the list of registered file types, check for the .app file extension. If the .app 
extension is not already listed, click New, type .app for Extension, and 
text/plain for MIME type.

b. In the list of registered file types, check for the .wsdl file extension. If the .wsdl 
extension is not already listed, click New, type .wsdl for Extension, and 
text/plain for MIME type.

4. To save your changes, click OK.

5. Expand the tree. Right-click Default Web Site, and select Properties.

6. On the ISAPI Filters tab, click Add. 

7. Add a filter with the following characteristics:

Filter Name: jakarta

Executable: <root>\Lincoln\IIS\bin\isapi_redirect.dll

8. If <is_IIS_default_app> is true (WebSDM is the IIS default application), complete 
the following. Otherwise, continue with step 9.
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a. Select the Documents tab.

b. Select the Enable Default Document (or Enable Default Content Page) 
checkbox, and set index.html as the top-most document.

c. When you exit the Properties dialog for Default Web Site, if you do not want 
to keep the default document settings for other virtual directories (for 
example, printers), click OK.

9. Right-click Default Web Site and select New > Virtual Directory. Set up a virtual 
directory for jakarta, as follows:

Alias: jakarta

Directory: <root>\Lincoln\IIS\bin

Access Permissions: Select the Read and Execute checkboxes only.

10. Add a web service extension:

a. Select the Web Services Extensions node.

b. Click the Add a new Web service extension link.

c. Set Extension name to jakarta.

d. Add the <root>\Lincoln\IIS\bin\isapi_redirect.dll file to the required 
files list.

e. Select the Set extension status to Allowed checkbox.

f. Click OK.

11. Right-click Default Web Site and select New/Virtual Directory. Use the wizard to 
set up a virtual directory for WebSDM, as follows:

Alias: <instance>

Directory: <root>\Lincoln\apps\<instance>\webapps\web_root

Access Permissions: Select the Read checkbox only.

12. Make index.html the default document for the <instance> virtual directory.

a. Right-click the <instance> virtual directory and select Properties.

b. Select the Documents tab, select the Enable default content page checkbox, 
and set index.html as the top-most default document. (If document 
index.html is not listed, create it using the Add button, and move the 
document to the top of the list.)

c. Click OK.

13. Select Start > Control Panel > Administrative Tools > System and Security > 
Services. Right-click the World Wide Web Publishing Service, and then click 
Restart.

Alternatively, run the following commands at the DOS prompt:

C:\ net stop w3svc
C:\ net start w3svc

1.3.8 Optional: Setting the System Timeout Interval
By default, WebSDM user sessions automatically time out after 30 minutes of 
inactivity. You can change this timeout interval to another value.
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1. Use a text editor, such as Notepad, to open: 
<root>\Lincoln\apps\<instance>\webapps\web_root\WEB-INF\web.xml.

2. Locate the <session-timeout> element.

3. Set the session timeout to another value (in minutes). For example:

<session-timeout>15</session-timeout>

4. Save your changes to the web.xml file.

1.3.9 Installing the websdm Service
For Windows 2003 SP2 only, update the icacls.exe utility by following the 
instructions located at http://support.microsoft.com/kb/943043.

1. If using a WebSDM instance name other than websdm, edit the file:

<root>\Lincoln\apps\<instance>\bin\install_service.bat

a. Change the value of SERVICE_NAME from websdm to the value of <instance>.

b. Change the value of the APPLICATION_DIR from websdm to the value of 
<instance>.

2. If using a WebSDM instance name other than websdm, edit the file:

<root>\Lincoln\apps\<instance>\bin\uninstall_service.bat

Change the value of SERVICE_NAME from websdm to the value of <instance>.

3. (Windows 2008 server) Right-click the 
<root>\Lincoln\apps\<instance>\bin\install_service.bat file, and then select 
Run as administrator.

(Windows 2003 server) Double-click the 
<root>\Lincoln\apps\<instance>\bin\install_service.bat file.

4. After install_service.bat has completed, inspect the transcript. There should be 
no errors. When you have finished, press any key.

5. (Windows 2008 server) Open the Start menu, select Administrative Tools, then 
Server Manager. Expand Configuration > Local Users and Groups > Users.

or

(Windows 2003 server) Right-click the server's desktop My Computer icon and 
select Manage. Expand System Tools > Local Users and Groups > Users.

6. Right-click <instance>_app and select Set Password.

7. In the Set Password for <instance>_app dialog box, click Proceed.

8. Change the password to satisfy site password policy restrictions, and then click 
OK.

9. (Windows 2008 server) Click Services.

or

(Windows 2003 server) Expand the Services and Applications directory, and then 
click Services.

Note: If you are using Single Signon (SSO), the WebSDM timeout 
must be set to be longer than the SSO timeout.
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10. Right-click the service named <instance> and select Properties.

11. On the Log On tab, select the This account radio button, and then clear the 
password fields and enter the password that you just changed.

12. On the Recovery tab, for both First Failure and Second Failure, select Restart the 
Service.

13. (Windows 2008 server) On the General tab, set Startup type to Automatic (Delayed 
Start).

14. Click OK.

1.4 Install Supporting Software

1.4.1 Installing a Disk Space Monitoring Utility
To support monitoring of disk space allocated to Oracle tablespaces used by WebSDM, 
you install the lt_DiskUtil.dll utility, a standalone windows executable.

This process is required if the Oracle database is running on a Windows server and no 
related products were previously installed. If the Oracle database is running on a 
UNIX host, or if any related products are already installed on the server, continue to 
Section 1.4.2, "Optional: Installing a SAS File Viewer".

1. Use Windows Explorer to view the installation media and locate the appropriate 
file: 

■ 32-bit server: lt_DiskUtil.dll

■ 64-bit server: lt_DiskUtil_x64.dll

2. Copy this file to C:\WINDOWS\system32.

3. 64-bit server: Rename the file from:

lt_DiskUtil_x64.dll

to:

lt_DiskUtil.dll

1.4.2 Optional: Installing a SAS File Viewer 
The SAS System Viewer or SAS Universal Viewer application is useful for inspecting 
the content of the SAS transport files that constitutes the data sources for WebSDM 
studies. This file viewer software is distributed without charge by SAS.

Note: This allows time for the database service to start before the 
WebSDM application service.

Note: If WebSDM and Oracle are not installed on the same server, 
the WebSDM and Oracle servers must map the same drive letter for 
the Oracle data files for the disk space monitoring utility to function 
correctly.
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1. Use a Web browser, such as Internet Explorer, to navigate to 
http://support.sas.com/downloads/index.htm.

2. Choose the SAS System Viewer or SAS Universal Viewer appropriate to your 
client operating system.

3. Follow the installation instructions provided for the download.

1.5 Configure WebSDM Application Properties Files
The website.properties file stores database connection information and points to the 
location of the executables. You review and modify this information as needed for 
your installation.

1. Navigate to <root>\Lincoln\apps\<instance>\webapps\web_
root\WEB-INF\classes\.

2. Use an editor, such as Notepad, to open the website.properties file.

3. Review the settings for the following values in the file:

user=websdm
pass=<password>
connect=jdbc:oracle:oci8:@websdm

4. If the value of <websdm_master_acct> is something other than websdm, change 
the value of user to that value.

5. Change the password to the value of <websdm_master_pass>.

6. If the value of <ora_net_service> is something other than websdm, change the 
connect string @websdm to that value.

7. Examine the drive and directory specified for logfile= and process_dir=. 
Modify these if needed, keeping in mind that the parent directory for \logs and 
\procs is created as the WORKING_DIR by running script set_permissions.bat 
(see Section 1.7, "Set File Permissions".) The parent directory name should be set to 
the value of <instance>.

8. Review the location specified for the R executable:

r_path=C:/Program Files/R/R-2.13.2/bin/R.exe

If necessary, modify this to match the location you specified when you installed R. 
For example, on a 64-bit server, the 32-bit version of R might have been installed 
by default to C:/Program Files (x86)/R/R-2.13.2/bin/R.exe.

9. Review the location specified for the Oracle sqlldr executable:

sqlldr_path=D:/oracle/product/11.2.0/dbhome_1/BIN/sqlldr.exe

If necessary, modify this to the correct location.

10. Review the default path provided for tablespace_datafileSpec. If necessary, 
modify the path to match your Oracle environment.

Note: Later, you will configure WebSDM to encrypt this password.

Note: With Oracle 10g and Oracle 11g, use oci8.
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1.6 Add Manifest Entries and Sign JAR Files
If you do not perform these steps, security-related dialog boxes appear for end users 
when they work with DataMontage graphs in applet mode, and DataMontage may 
even be completely blocked by a client machine's security settings. To perform these 
steps, you need access to the Java jar and jarsigner utilities in the Java jdk1.6\bin 
directory (jdk1.6\bin must be in the application server's PATH), and you must have 
access to your company's jar signing process.

1. From the <root>:\Lincoln\apps\<instance>\webapps\web_
root\AppJars\DataMontage23\ folder, copy files lti.jar and DataMontage.jar to 
a temporary folder such as C:\temp\UpdateJarManifest\.

2. Update the manifest is both JAR files:

a. In the temporary folder where you copied the JAR files, create a text file and 
save it. The example later in this procedure uses the name MANIFEST.MF.

b. Insert two lines of text in the file, supplying the fully qualified domain name 
of the Windows application server (or its IP address) and the connection port 
on each line. For example:

Codebase: <server_name>.example.com:80
Caller-Allowable-Codebase: <server_name>.example.com:80

Alternatively you can use an asterisk (*) as a wildcard for the most specific 
part of the domain name, but this will result in a less secure deployment.

c. Be sure to insert a line break after the second line of text. Then save and close 
the file.

d. Open a DOS Command window and navigate to the temporary folder 
containing the JAR files and the text file you created.

e. At the DOS prompt, issue the following commands, replacing MANIFEST.MF 
with the name of the text file you created:

jar -ufm DataMontage.jar MANIFEST.MF
jar -ufm lti.jar MANIFEST.MF

3. You must now sign the modified JAR files before they will work correctly within 
the WebSDM application. Use your company's jar signing process to perform this 
signing task, which probably includes using Java's jarsigner utility. (See 
http://docs.oracle.com/javase/7/docs/technotes/tools/windows/jarsigner.
html for additional information about this utility.)

4. Copy both signed JAR files to the 
<root>:\Lincoln\apps\<instance>\webapps\web_root\AppJars\DataMontage23\ 
folder, replacing the original files.

5. Finally, copy the signed DataMontage.jar file to the 
<root>:\Lincoln\apps\<instance>\webapps\web_root\WEB-INF\lib\folder, 
replacing the original file. (You do not need a copy of lti.jar in this location.)

1.7 Set File Permissions
1. Navigate to the folder <root>\Lincoln\apps\<instance>\bin.

2. Use a text editor to open the file set_permissions.bat and review the values of 
SERVICE_NAME, INSTALL_ROOT, APPLICATION_DIR, and WORKING_DIR:
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a. If the value of <Instance> is other than websdm, change the values of 
SERVICE_NAME, APPLICATION_DIR, and WORKING_DIR to the value of <instance>.

b. If the value of <root> is other than the C drive, change the value of the 
INSTALL_ROOT to the value of <root>.

c. If the D drive is not an acceptable location for the working directory, change 
the drive for WORKING_DIR to an acceptable drive.

d. Verify that CATALINA_HOME is defined correctly.

3. Optionally, grant permissions to a Windows group of non-administrator users 
who might require access to the log files and \web_root folder.

a. While editing the set_permissions.bat file, locate the following lines: 

REM -
REM - Local Administrators group
REM - 
REM SET ADMIN_GROUP=Study Operators

b. Remove REM from the REM SET ADMIN_GROUP line.

c. Replace Study Operators with the appropriate Windows user group that 
requires access.

4. If changes are needed, edit, save, and close the file.

5. (Windows 2008 server) Right-click the set_permissions.bat file, and then select 
Run as administrator.

(Windows 2003 server) Double-click the set_permissions.bat file.

6. When prompted, press any key.

7. Examine the log file <root>\Lincoln\apps\<instance>\logs\set_
permissions.log for errors. If there are errors, contact Oracle.

1.8 Create the Submissions Folder
1. Create a directory, <submissions_folder>, to serve as the root for clinical data 

submissions. This directory will later be specified on the Site Options page in 
WebSDM as the highest level directory within which users can browse for data.

■ If <submissions_folder> will be located on the same drive as the WORKING_DIR 
specified in the previous procedure, it should not be set at or below WORKING_
DIR. 

■ If <submissions_folder> will be located on the same drive as the WebSDM 
application software, it should not be set at or below 
<root>\Lincoln\apps\<instance>. 

■ The recommended <submissions_folder> location is at or below 
D:\ClinicalData.

2. The Windows <instance>_app user (created in section 1.3.9) needs Read and Write 
permissions on the new directory. To ensure that these permissions are in place, 
right-click the <submissions_folder> directory in Windows Explorer. Select 
Properties, the Security tab, and the <instance>_app user.

3. Save any changes.
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1.9 Start the websdm Service
1. In the Services Control Panel, right-click the <instance> Windows service, then 

click Start or, if the service is already running, click Restart.

Alternatively, execute the net start command in a Command window. For 
example, if the value of <instance> is the default websdm:

C:\> net start websdm

2. In the Services Control Panel, right-click the World Wide Publishing Service, then 
click Start or, if the service is already running, click Restart.
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2Configure the WebSDM Application 

Chapter 2 describes WebSDM configuration.

2.1 Prerequisites
Before you access the WebSDM application and set site options for your organization, 
at least one client computer must be set up. See the instructions in the WebSDM_Client_ 
Installation_Instructions.pdf file supplied on the product ZIP file from My Oracle 
Support (https://support.oracle.com).

2.2 Setting WebSDM Site Options
Perform the following steps to prepare WebSDM for use by others at your site.

1. Open Internet Explorer. If you made WebSDM the default application for IIS, enter

http://<server name>

Otherwise, navigate to:

http://<server name>/<instance>

The WebSDM Login page appears. 

2. Log into WebSDM using the default administrative account:

Username: admin

Password: <app_admin_pass_default>

where <app_admin_pass_default> is the password provided by Oracle. 

You are prompted to change the password for the admin account.

3. Change the password for the admin account to the value of <app_admin_pass>.

4. After changing the password, log in again to the admin account, using the new 
password. The WebSDM home page appears.

Note: If your server is configured to require SSL connections, use 
https:// instead of http://.

Note: The username admin is predefined with maximum privileges 
in WebSDM, and has the special status Superuser. Log into WebSDM 
with this username in subsequent steps that reference a Superuser.

https://support.oracle.com
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5. Click Settings, and then click Set Site Options.

The Set Site Options page appears.

Figure 2–1 Set Site Options page

Figure 2–2 Set Site Options page (continued)

6. Edit the Site Options as appropriate for your installation. 
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7. Set the Profile for new accounts.

■ Set the Root directory of source data for all applications and studies to the 
<submissions_folder> created in Section 1.9, "Start the websdm Service".

■ Set the SMTP Server to the name of the server you use for outgoing email.

■ For Error Email, supply the address to which server error reports should be 
sent. 

■ If you license PPD Patient Profiles, select Enable PPD Patient Profiles.

■ If you license Empirica Study, select Enable Empirica Study Features.

■ Set other options as appropriate for your installation.

8. Click Save.

2.3 Encrypt Password and Restart Listener
1. Click Settings, and then click Set Database Connection.

2. Verify that Username contains the value of <websdm_master_acct>.

3. Enter <websdm_master_pass> for the Password.

4. Enter <websdm_master_pass> for the Confirm Password.

5. Select Encrypt Password.

6. Click Save.

7. Click Restart Listener.

8. Click Exit to log out of WebSDM.
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3Perform Post Installation Procedures 

This chapter describes the activities to be performed post installation.

3.1 Setting Up MedDRA Accounts

3.1.1 Background
Install each version of MedDRA used by the studies that you plan to load into 
WebSDM. Even if your own studies do not use MedDRA version 11.0, install version 
11.0 because the LTI sample study uses it. The sample study serves as an anchor to the 
standard reports feature of WebSDM.

The process described in this section creates and loads an account named MEDDRAx 
for each MedDRA version, where x represents the two- or three-digit MedDRA 
version. For example, accounts MEDDRA70 and MEDDRA131 create and load 
MedDRA versions 7.0 and 13.1.

The same MedDRA account can be used by multiple WebSDM instances.

3.1.2 Prerequisites
Create a folder for loading the MedDRA data (for example, c:\meddra). This folder is 
referred to as <meddra_base> in the instructions that follow.

For each MedDRA version that you plan to load, you need two zip files:

■ WebSDM MedDRA Dictionary zip file

Locate the WebSDM MedDRA Dictionary zip file for the MedDRA version on the 
WebSDM Installation media. 

The zip file is named MEDDRAx.zip 

where x represents the two- or three-digit MedDRA version.

■ MSSO MedDRA Dictionary zip file

Obtain the licensed MedDRA Dictionary zip file for the MedDRA version from the 
MedDRA MSSO (Maintenance and Support Services Organization, 
http://www.meddramsso.com).
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3.1.3 Installing a MedDRA Version Dictionary
For each MedDRA version you need to load, complete the following steps, where x 
represents the two- or three-digit MedDRA version.

1. Unzip the WebSDM and MSSO Dictionary files:

a. Unzip MEDDRAx.zip from the WebSDM installation media into <meddra_
base>. This creates a folder named <meddra_base>\MEDDRAx\ containing 
several files and two subfolders named ctrl and MedDRA.

b. Unzip the zip file from MSSO containing the correct MedDRA version into 
<meddra_base>\MEDDRAx. This creates a folder named <meddra_
base>\MEDDRAx\MedDRA\medascii containing the *.asc data files.

2. Edit the following files in folder <meddra_base>\MEDDRAx using a text editor. Save 
and close each file after editing.

a. Create_MedDRA.sql

Review the DEFINE ORACLE statements. By default, this script stores tablespace 
files in a subfolder of oradata named orcl (..\oradata\orcl). Edit the path 
used by the DEFINE ORACLE_DBF_FILE statement, if necessary, to indicate a 
different location.

You must specify a path that already exists on your computer. The path can be 
in any location, although it is typically in a subfolder of oradata. 

b. Load_MedDRA.imp

Change the Oracle net service name at the end of the line 
userid=MEDDRAx@orcl from orcl to the value of <ora_net_service>.

c. Restore_meddra_terms.bat 

Change the name of the Oracle net service at the end of the ninth line: 

SET SID=ORCL 

from orcl to the value of <ora_net_service>.

3. Open a command window and change to the <meddra_base>\MEDDRAx folder. 
Execute the following commands:

a. Execute the Create_MedDRA.sql script from an account with DBA privileges.

C:\> sqlplus <ora_dba_acct>@<ora_net_service> @Create_MedDRA.sql 

When prompted for the password, enter <ora_dba_pass>. The script also 
prompts you to supply a password for the new MedDRA account. Supply the 
value of <meddraX_ora_pass>.

b. Execute the batch file: Load_MedDRA.bat.

When prompted for the password of the newly created MedDRA account, 
supply the value of <meddraX_ora_pass>.

The file imp_MEDDRAx.log is produced. You can compare its row counts with 
those in the provided file exp_MEDDRAx.log. The row counts should be the 
same.

c. Execute the batch file restore_meddra_terms.bat.

You are again prompted to supply the password of the new MedDRA account. 
As the script completes, you can verify the row count checks displayed on the 
screen. 
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4. Clean up the file, if errors occur.

If errors occur while running the supplied MedDRA account installation scripts, 
you can correct the problem, clean up, and start over by running the Drop_
MedDRA.sql script in the respective MEDDRAx folder. Execute the script from an 
account with DBA privileges, and supply <ora_dba_pass> when prompted for the 
password.

C:\> sqlplus <ora_dba_acct>@<ora_net_service> @Drop_MedDRA.sql 

3.2 Installing the LTI Sample Studies
To enable standard report definitions that are supplied for WebSDM, you must install 
a sample application and study. Installation of MedDRA 11.0 is a prerequisite for this 
procedure. One sample study is required to enable the standard reports features of the 
software, and is referenced in the Operational Qualification test supplied on the 
installation media.

3.2.1 Installing the Required Sample Study
1. Locate the LTI_Sample_Application.zip file on the installation media, and extract 

the contents of this file to a location on the machine where WebSDM is installed, 
under the Root directory <submissions_folder> specified on the Site Options page. 
To make sure that path names stored in the archive are used, specify the 
appropriate option when extracting (for example, in WinZip, select the Use folder 
names checkbox).

2. Log into WebSDM as a Superuser.

3. Click the Setup tab, and then click Register Application.

a. For the Name property, specify LTI. The sample study requires this exact 
application name to function properly. Do not modify the application name.

b. For the application Path, use the Browse link and then locate and select the 
LTI application folder.

c. For Default codelists in metadata, use the supplied value, Standard 
Codelists.

d. For Default MedDRA account, specify MEDDRA110.

e. For Default SDTM version, specify sdm312.

4. When you click OK, the Auto-Register Studies page appears. Three studies, 
SAMP1, SAMP1_311, and SAMP1_312, are offered for automatic registration. 

a. For Study SAMP1 and Study SAMP1_311, use the drop-down control to 
select Defer study registration.

b. For Study SAMP1_312, keep the default value, Generate a new metadata file 
with standard codelists. 

c. To begin automatic registration, click OK.

d. When registration is complete, click Continue.

The Applications page appears, with the entry LTI.

5. From the LTI actions menu, click Load. 

6. On the Select Studies/Pools to Load page, select the Include checkbox for study 
SAMP1_312.
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7. Click Next, Next, and Submit to begin the run.

8. Click Continue, and occasionally refresh the Run History page to view the run 
status. After a few minutes, the run completes.

The required sample study that was registered and loaded in the previous steps is 
compliant with CDISC SDTM version 3.1.2. You can install additional sample 
studies that are compliant with CDISC SDTM versions 3.1 and 3.1.1, respectively. 
Section 3.2.2, "Optional: Registering Other LTI Sample Studies" and Section 3.2.3, 
"Optional: Loading the Optionally Registered Studies" are optional.

3.2.2 Optional: Registering Other LTI Sample Studies
Perform the steps below to register other LTI sample studies.

1. Click the Setup tab, and then click Studies > Pools. 

2. From the Application drop-down list, select LTI. 

3. Click Register Study.

4. For the Name property, specify SAMP1 (or SAMP1_311).

5. For the SDTM version, specify sdm31 (or sdm311).

6. Accept the MedDRA account, MEDDRA110.

7. For the Data location, use the Browse link and navigate to \crt\datasets\. On 
the row for SAMP1 (or SAMP1_311), click Select.

8. Accept the Metadata value. Generate a new metadata file with standard codelists.

9. Click Generate Metadata, and click OK to confirm. 

The application creates the metadata file and adds the name to the Metadata field.

10. Click OK.

3.2.3 Optional: Loading the Optionally Registered Studies
1. On the Studies and Study Pools page, on the Action menu, click Load. 

2. Click Next.

3. Click Next.

4. Click Submit.

5. Click Continue, and occasionally refresh the Run History page to view the run 
status. After a few minutes, the run completes.

6. Repeat steps 1 through 5 to load each registered study.

7. Click Exit to log out of WebSDM.

3.3 Optional: Customize WebSDM
You can customize WebSDM by making one or more of the following alterations. For 
more detailed instructions, see the WebSDM Help.
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3.3.1 Replacing the Default Home Page
A default home page appears when users log into WebSDM. Another home page file is 
supplied for use by installations that license the optional Empirica Study features. You 
can replace either of the home pages with a custom home page. You can create a single 
home page for all users, or specify a different customized home page for each 
WebSDM login group.

1. Use an HTML editor to design each new home page, and save it as an HTML file.

2. Use a text editor to remove the <body> tag at the beginning of the file and the 
</body> tag at the end of the file, leaving all other HTML content that occurs 
between those tags intact.

3. Save the edited file with the extension, .inc., in the following directory:

<root>\Lincoln\apps\<instance>\webapps\web_root\customhomes\ 

For example, EStudy_home.inc is the name of the home page file that is supplied 
for use by installations using the Empirica Study application.

4. Log into WebSDM as a user with the Administer Users permission. 

5. Click Settings.

6. Click Edit Login Groups.

7. Supply the name of the home page file in the customhomes\ directory that should 
appear when the members of this login group log in to WebSDM.

3.3.2 Replacing the Default Logotype
A logotype appears in the upper left corner of WebSDM pages. An additional logotype 
file is supplied for use by installations that license the optional Empirica Study 
features. You can replace either of the logotypes delivered with WebSDM with a 
logotype of your own design. You can create a custom logotype for all users, or specify 
different logotypes for each WebSDM login group.

1. Select a .bmp or .gif file with dimensions of approximately 150x100 pixels and 
copy it to the <root>\Lincoln\apps\<instance>\webapps\Web_root\image 
directory. For example, E_logo.gif is the image file that is supplied for use by 
installations with the Empirica Study application.

2. Log into WebSDM as a user with the Administer Users permission.

3. Click Settings.

4. Click Edit Login Groups and supply the name of the logotype file in the image\ 
directory that appears for members of this login group. 

3.3.3 Customizing the List of FDA Review Divisions 
When you register an application in WebSDM, you can select an FDA review division 
for that application from a dropdown list. This list is populated with values from the 

Note: If more than one login group is set up in WebSDM, repeat this 
procedure for each login group. 

Note: If more than one login group is set up in WebSDM, repeat 
steps 3 and 4 for each login group.
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FDA_REVIEW_DIVISIONS table owned by <websdm_master_acct>. You can add 
values to the list of FDA review divisions.

If new review divisions are created, complete the following steps to add the new 
divisions:

1. Launch SQL*Plus and connect using the <websdm_master_acct>.

2. Execute one or more SQL statements in the following form:

INSERT INTO FDA_REVIEW_DIVISIONS
(REVIEW_DIVISION, ORDER_BY)
VALUES('[new review division]', [sequence number]);

3. Commit your changes. 

New values are immediately available for selection in WebSDM on the Register 
Application page.

4. Exit SQL*Plus.

3.3.4 Specifying the Profile for New Accounts
When you register an application or study in WebSDM, WebSDM creates an Oracle 
database account for the application or study. These accounts are associated with the 
Oracle database profile named DEFAULT, unless you create an alternate profile and 
direct WebSDM to use that profile instead.

For guidelines on creating an alternate profile for your application and study accounts, 
see Appendix B, "Optional: Creating Alternate Profiles".

After you have created an alternate profile, you must specify that WebSDM is to use it 
for new study accounts:

1. Log in to WebSDM as an administrator.

2. Click Settings.

3. Click Set Site Options.

4. In the Database Accounts and File System Structure section, select the 
appropriate Profile for new Accounts.

3.4 Verify the WebSDM Installation
For Installation Qualification (IQ) and Operational Qualification (OQ) testing, refer to 
the IQ_Test.doc and OQ_Test.doc files supplied on the installation media.
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ANotes on the Installation of R

The 32-bit version of R for Windows version 2.13.2 must be installed on the WebSDM 
application server. Licensing information for R can be found at 
http://www.r-project.org. 

To install R version 2.13.2:

1. Log onto the WebSDM server as a user with administrator access.

2. Access http://cran.r-project.org. In the Download and Install R section, click 
Download R for Windows.

3. On the next page, click base. 

4. Under Other builds, click Previous releases.

5. Click R 2.13.2, and then click Download R 2.13.2 for Windows.

6. Follow instructions in the installation wizard, or review the instructions available 
at Installation and other instructions to install R. 

When running the installation wizard, even if you are installing to a 64-bit server, 
in the Select Components screen, choose the 32-bit user installation option.
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BOptional: Creating Alternate Profiles 

WebSDM creates a database account for each application and study that is registered. 
The accounts associated with studies own the tables that contain the clinical data 
comprising a study. These tables are created and populated during loading and 
checking runs. The accounts associated with applications are reserved for future use.

WebSDM assigns randomly generated passwords for these accounts. The passwords 
satisfy the following criteria:

■ The password is 16 characters long.

■ The password contains at least one lowercase alphabetic character.

■ The password contains at least one uppercase alphabetic character.

■ The password contains at least one number.

■ The password contains at least one nonalphanumeric character. 

WebSDM does not support the expiration or resetting of the password for these 
accounts. If your site has installed a new version of WebSDM and your database is 
configured with a DEFAULT profile that imposes limits on the duration of passwords 
or that uses a password verifying function more restrictive than the criteria specified 
above, you must define an additional profile and use the WebSDM site options activity 
to associate that profile with the application and study accounts.

The following sample script creates a profile for the application and study accounts. 
You can modify the script to meet your company security policy requirements. Execute 
it while connected as the SYS user.

CREATE OR REPLACE FUNCTION verify_websdm_acct_pw
(username varchar2,
  password varchar2,
  old_password varchar2)
  RETURN boolean IS 
   n boolean;
   m integer;
   differ integer;
   isdigit boolean;
   ischar  boolean;
   ispunct boolean;
   digitarray varchar2(20);
   punctarray varchar2(25);
   chararray varchar2(52);
 
BEGIN 
   digitarray:= '0123456789';
   chararray:= 'abcdefghijklmnopqrstuvwxyzABCDEFGHIJKLMNOPQRSTUVWXYZ';               
   punctarray:='!"#$%&()``*+,-/:;<=>?_';
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   -- Check for the minimum length of the password
   IF length(password) < 16 THEN
      raise_application_error(-20002, 'Password length less than 16');
   END IF;
   -- Check if the password contains at least one letter, one digit and one
   -- punctuation mark.
   -- 1. Check for the digit
   isdigit:=FALSE;
   m := length(password);
   FOR i IN 1..10 LOOP 
      FOR j IN 1..m LOOP 
         IF substr(password,j,1) = substr(digitarray,i,1) THEN
            isdigit:=TRUE;
             GOTO findchar;
         END IF;
      END LOOP;
   END LOOP;
   IF isdigit = FALSE THEN
      raise_application_error(-20003, 'Password should contain at least one digit, 
one character and one punctuation');
   END IF;
   -- 2. Check for the character
   <<findchar>>
   ischar:=FALSE;
   FOR i IN 1..length(chararray) LOOP 
      FOR j IN 1..m LOOP 
         IF substr(password,j,1) = substr(chararray,i,1) THEN
            ischar:=TRUE;
             GOTO findpunct;
         END IF;
      END LOOP;
   END LOOP;
   IF ischar = FALSE THEN
      raise_application_error(-20003, 'Password should contain at least one digit, 
one character and one punctuation');
   END IF;
   -- 3. Check for the punctuation
   <<findpunct>>
   ispunct:=FALSE;
   FOR i IN 1..length(punctarray) LOOP 
      FOR j IN 1..m LOOP 
         IF substr(password,j,1) = substr(punctarray,i,1) THEN
            ispunct:=TRUE;
             GOTO endsearch;
         END IF;
      END LOOP;
   END LOOP;
   IF ispunct = FALSE THEN
      raise_application_error(-20003, 'Password should contain at least one digit, 
one character and one punctuation');
   END IF;
 
   <<endsearch>>   
   -- Everything is fine; return TRUE ;   
   RETURN(TRUE);
END;
/
show errors;
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create profile WEBSDM_STUDIES_PROFILE limit 
  COMPOSITE_LIMIT  UNLIMITED
  SESSIONS_PER_USER  UNLIMITED
  CPU_PER_SESSION  UNLIMITED
  CPU_PER_CALL  UNLIMITED
  LOGICAL_READS_PER_SESSION  UNLIMITED
  LOGICAL_READS_PER_CALL  UNLIMITED
  IDLE_TIME  UNLIMITED
  CONNECT_TIME  UNLIMITED
  PRIVATE_SGA  UNLIMITED
  FAILED_LOGIN_ATTEMPTS  5
  PASSWORD_LIFE_TIME  UNLIMITED
  PASSWORD_REUSE_TIME  UNLIMITED
  PASSWORD_REUSE_MAX  UNLIMITED
  PASSWORD_LOCK_TIME  UNLIMITED
  PASSWORD_GRACE_TIME  UNLIMITED
  PASSWORD_VERIFY_FUNCTION verify_websdm_acct_pw

After creating a profile, use Settings > Set Site Options in WebSDM to associate it 
with application and study accounts. Use the control labeled Profile for new Accounts 
in the Database Accounts and File System Structure section to select it.

For more information, see the Oracle Database Security Guide, 10g Release 2, Chapter 7 
Security Policies, Section Password Complexity Verification, or Oracle Database Security 
Guide, 11g Release 2, Chapter 3, Configuring Authentication, Section Customizing 
Password Complexity Verification.
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CConfigure WebSDM for SSO

This section applies only to customers that plan to configure WebSDM for an SSO 
(Single Sign-On) environment.

This is optional functionality. Begin by reviewing the Configuring Single Sign-On for 
WebSDM/Empirica Study topic in the WebSDM/Empirica Study Help.

Before configuring WebSDM for SSO, you must install Oracle Access Manager (OAM) 
on a server and configure a Webgate agent. Contact Oracle for assistance.

C.1 Configure WebSDM SSO
1. Navigate to <root>\Lincoln\apps\<instance>\webapps\web_

root\WEB-INF\classes.

2. Open website.properties and uncomment the two lines for required SSO 
properties:

#sso.plugins=com.oracle.hsgbu.empirica.sso.EmpiricaSsoPlugin
#sso.EmpiricaSsoPlugin.username.header=oam-remote-user

3. Optionally, enter an SSO alternative logout URL. Uncomment this line and change 
the value of <oam_server> to the name for the fully qualified OAM server:

#sso.EmpiricaSsoPlugin.logoutRedirectUrl= http://<oam_
server>/oam/server/logout

For example:

sso.EmpiricaSsoPlugin.logoutRedirectUrl= 
http://myserver.com:14100/oam/server/logout

4. Configure the session timeout to be longer than the SSO timeout.

The default WebSDM session timeout is 30 minutes. Modify WEB-INF/web.xml 
and <sessiontimeout> to be longer than the SSO session timeout.

5. Configure the WebSDM server for native login:

a. Edit /Lincoln/apps/<instance>/conf/server.xml.

b. Under <Service name="Catalina">, add

<Connector address="127.0.0.1" port="8080" protocol="HTTP/1.1"
connectionTimeout="20000" redirectPort="8443" />

c. If the port 8080 is not available on the server, change the value of the port 
attribute to an available port.

6. Restart the WebSDM service.
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C.2 Validate WebSDM SSO
1. Open a browser window and type the WebSDM URL.

2. At the Login prompt, enter your SSO username and password. 

The WebSDM home page appears.

3. On the WebSDM server, start a browser and enter the WebSDM URL using the 
port number for native login that you set in section C.1.

4. At the WebSDM login prompt, enter a WebSDM username that is a Superuser 
and enter the password. 

The WebSDM home page appears.
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DConfigure WebSDM to Access an Oracle Life 
Sciences Data Hub Instance

This section applies only to customers who will load SDTM-formatted study data from 
an instance of the Oracle Life Sciences Data Hub (LSH), version 2.2.

To perform these steps you must know the Oracle DBA account/password and the 
Oracle master account name/password for WebSDM. In addition, you must have the 
following information pertaining to an existing LSH database instance: 

■ <LSH_consumer_acct>—LSH database account having "LSH Consumer" role.

■ <LSH_consumer_pass>—Password for the above LSH database account.

■ <LSH_host>—LSH database server.

■ <LSH_port>—Port number where LSH database server listens for incoming 
connections

■ <LSH_SID>—Oracle system identifier for the LSH database instance.

■ <LSH_service_name>—Alias for the LSH database address containing connection 
information.

Finally, you need access to files extracted from database-3_1_2_1_xxx.zip, as 
described in section 1.2.3, or access to the WebSDM installation media.

D.1 Add Net Service Name for LSH Database
On the WebSDM database server, add an entry for the LSH database service name to 
the tnsnames.ora file.

<LSH_service_name>=
(DESCRIPTION=
   (ADDRESS=
       (PROTOCOL=TCP)
       (HOST=<LSH_host>)
       (PORT=<LSH_port>)
   ) (CONNECT_DATA=(SID=<LSH_SID>))
)
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D.2 Create a Database Link
1. Connect to WebSDM DB as <ora_dba_acct>.

a. Type this command:  C:> sqlplus <ora_dba_acct>@<ora_net_service>

b. When prompted for the password, enter <ora_dba_pass>.

2. Grant Create DB Link privilege to the websdm master account by typing:

SQL>GRANT CREATE DATABASE LINK TO <websdm_master_acct>;

3. Exit SQL*Plus.

4. Connect to WebSDM DB as <websdm_master_acct>.

a. Type this command: C:> sqlplus <websdm_master_acct>@<ora_net_
service>

b. When prompted for the password, enter <websdm_master_pass>.

5. Run the following command, with values substituted as appropriate. The <DB_
link_name> is a new name that you provide.

SQL>CREATE DATABASE LINK <DB_link_name> CONNECT TO <LSH_consumer_acct> 
IDENTIFIED BY <LSH_consumer_pass> USING '<LSH_service_name>';

6. Exit SQL*Plus.

7. Repeat step 1 to connect to WebSDM DB again as <ora_dba_acct>.

8. Revoke Create DB Link privilege from the websdm master account by typing:

SQL>REVOKE CREATE DATABASE LINK FROM <websdm_master_acct>;

D.3 Install and Run a PL/SQL Package in the LSH Database
1. Locate the file create_lsh_pkg.plb either in the directory to which you extracted 

files from database-3_1_2_1_xxx.zip or from the .zip file on the WebSDM 
installation media.

2. Connect to the LSH instance as <LSH_consumer_acct>:

C:> sqlplus <LSH_consumer_acct>/<LSH_consumer_pass>@<LSH_service_name>;

3. Run this command: 

SQL>@create_lsh_pkg.plb

4. Exit SQL*Plus.

Note: The WebSDM application does not require this entry. Use it to 
access the LSH database and execute the SQL commands listed below.

If you do not want to modify tnsnames.ora, you can substitute the 
value of <LSH_service_name> directly in the SQL commands in steps 
D.2 and D.3. Replace <LSH_service_name> with:

(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=<LSH_
host>)(PORT=<LSH_port>))

     (CONNECT_DATA=(SID=<LSH_SID>)))
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D.4 Set Site Option to Allow LSH Import
1. Log into WebSDM using the default administrative account.

2. Click the Settings link at the top right corner of the page.

3. Click Set Site Options.

4. Select the Allow data import from Oracle Life Sciences Data Hub option if it is 
not already selected.

5. Click Save.

6. Click Continue.

7. Log out.
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EConfigure WebSDM to Access an Oracle 
Health Sciences InForm Instance

This section applies only to customers who will load SDTM-formatted study data from 
an Oracle Health Sciences InForm instance.

To perform these steps you must know the Oracle DBA account/password and the 
Oracle master account name/password for WebSDM. In addition you must have the 
following information pertaining to an existing InForm database instance: 

■ <InForm_acct>—InForm database account containing SDTM-formatted study 
data.

■ <InForm _pass>—Password for the above InForm database account.

■ <InForm _host>—InForm database server.

■ <InForm _port>—Port number where InForm database server listens for incoming 
connections.

■ <InForm _SID>—Oracle system identifier for the InForm database instance.

■ <InForm _service_name>—Alias for the InForm database address containing 
connection information.

Finally, you need access to files extracted from database-3_1_2_1_xxx.zip, as 
described in section 1.2.3, or access to the WebSDM installation media.

E.1 Add Net Service Name for InForm Database
On the WebSDM database server, add an entry for the InForm database service name 
to the tnsnames.ora file.

<InForm_service_name>=
(DESCRIPTION=
   (ADDRESS=
       (PROTOCOL=TCP)
       (HOST=<InForm_host>)
       (PORT=<InForm_port>)
   ) (CONNECT_DATA=(SID=<InForm_SID>))
)
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E.2 Create a Database Link
1. Connect to WebSDM DB as <ora_dba_acct>.

a. Type this command:

C:> sqlplus <ora_dba_acct>@<ora_net_service>

b. When prompted for the password, enter <ora_dba_pass>.

2. Grant Create DB Link privilege to the websdm master account by typing:

SQL>GRANT CREATE DATABASE LINK TO <websdm_master_acct>;

3. Exit SQL*Plus.

4. Connect to WebSDM DB as <websdm_master_acct>.

a. Type this command: 

C:> sqlplus <websdm_master_acct>@<ora_net_service>

b. When prompted for the password, enter <websdm_master_pass>.

5. Run the following command, with values substituted as appropriate. The <DB_
link_name> is a new name that you provide.

SQL>CREATE DATABASE LINK <DB_link_name> CONNECT TO <InForm_acct> 
IDENTIFIED BY <InForm_pass> USING '<InForm_service_name>';

6. Exit SQL*Plus.

7. Repeat step 1 to connect to WebSDM DB again as <ora_dba_acct>.

8. Revoke Create DB Link privilege from the websdm master account by typing: 

SQL>REVOKE CREATE DATABASE LINK FROM <websdm_master_acct>;

E.3 Set Site Option to Allow InForm Import
1. Log into WebSDM using the default administrative account.

2. Click the Settings link at the top right corner of the page.

3. Click Set Site Options.

4. Select the Allow data import from Oracle Health Sciences InForm option, if it is 
not already selected.

5. Click Save.

6. Click Continue.

7. Log out.

Note: The WebSDM application does not require this entry. Use it to 
access the InForm database and execute the SQL commands listed 
below.

If modifying tnsnames.ora is not desired, you can substitute the value 
of <InForm_service_name> directly in the SQL commands in steps C.2 
and C.3. Replace <InForm_service_name> with:

(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=<InForm_host>)
(PORT=<InForm _port>)) (CONNECT_DATA=(SID=< InForm_SID>)))
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